
  
 
 Securitron Magnalock Corp. www.securitron.com ASSA ABLOY, the global leader  
 Tel 800.624.5625 techsupport@securitron.com in door opening solutions 
 

 

© Copyright, 2013, all rights reserved  PN# 500-33510 
  Rev. A,  06/13 

 
 

 
 
 
 

 

 

 

DKC Digital Keypad Controller 

Installation & Operating Instructions 

 
How to install and program the  

DKC with the DKC Programming Tool  
 

 

 
 
 
 
 
 
 
 

  



 
 

 PN# 500-33510 
 Page 2 Rev. A, 06/13 

Table of Contents 
 

 
Introduction ...................................................................................................................................... 3 

Installation ........................................................................................................................................ 3 

Connecting to ASSA ABLOY AperioTM Products .......................................................................... 6 

DIP Switch Position ......................................................................................................................... 7 

Additional Hard Wired Options ..................................................................................................... 7 

System Reset ................................................................................................................................... 9 

Battery Maintenance ....................................................................................................................... 9 

The DKC Programming Tool .......................................................................................................... 9 

Connecting the DKC to the DKC Programming Tool ................................................................ 9 

DKC Programming Tool Overview .............................................................................................. 11 

The Status Form ............................................................................................................................ 11 

The Configuration Form ............................................................................................................... 11 

DKC Programming Using the DK-37 or DK-38 Digital Keypads .......................................... 17 

DKC Programming Options on the DKC CPU Board ............................................................... 19 

Technical Support ......................................................................................................................... 19 

 
 

  



 
 

 PN# 500-33510 
 Page 3 Rev. A, 06/13 

Introduction   
The DKC Digital Keypad Controller by Securitron is a dual door access control system designed 
for medium/high security control of electric locks. It can be connected to two external keypads 
(sold separately), card readers (sold separately) and/or ASSA ABLOY AperioTM hubs (sold 
separately) and controls two doors either independently or combined for a man trap function. 
With three different means of programming, the setup and maintenance of the DKC can range 
from easy to advance depending on the user’s needs. 
 
Product Features 

 Access control of up to two doors either independently or combined for a man trap 
function  

 Compatible with most 26-bit, Wiegand 2601 devices, including DK-37 and DK-38 keypads 
and HID Wiegand-compatible Prox and iClass® readers, as well as the ASSA ABLOY 
AperioTM family of wireless products  

 Wiegand communications for cable lengths of up to 500 feet 
 A database of 250 codes for each door stored in non-volatile memory 
 Three programming method options include on-board programming, advanced 

programming using the DK-37 or DK-38, and computer-based programming using the 
DKC Programming Tool  

 Real time clock with battery back-up 
 Three programmable user selectable option relays for each door 
 Door position switch inputs, user code disable inputs and hard code disable inputs, 

request to exit inputs, and tamper inputs that alert user that the keypad/reader has been 
removed from its mounting surface 

 Facility code only mode for Wiegand 2601 devices 
 Outputs for red, yellow, and green light indicators, along with an audible beeper  
 Time/date stamped event log that maintains the last 2000 events 
 Two unregulated DC power outputs for powering external equipment and locks 
 Two 12 VDC regulated outputs for powering of the external keypads/readers 
 Expansion port for future upgrades 
 USB 2.0 computer interface 
 DKC Programming Tool saves setup and database information to files on the computer for 

extra protection along with encryption of the files for security 
 
Box Contents 
DKC Digital Keypad Controller with cover screws  
USB Memory Stick with DKC Programming Tool  
3’ USB Cable  
Installation & Operating Instructions  

Installation   
The DKC must be installed in a dry location free from extreme temperature and humidity.    
 
Power Selection  
The DKC operates on either 12V or 24V AC or DC. This connection is made at the terminal 
marked MAIN IN. The polarity of this connection for AC or DC can be connected to either 
terminal because of the on-board rectifier. Be sure that the power source is of adequate capacity 
to operate the lock, keypads and the DKC. Please see Table 1 for power consumption. 
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DKC Power Consumption  12V 24V 
DKC (excluding keypads) 250 mA 250 mA 
DK-37 or DK-38 Keypad (each) 100 mA 100 mA 
Electronic Lock  Consult lock manual  Consult lock manual 
Aperio Hub (each) 250 mA 250 mA 

 
Table 1: DKC Power Consumption 

 
Connecting the Keypad Cable to the CPU Board 
There are 9 color coded wires in the keypad cable. Refer to Figure 1 and Table 2 below and 
connect each wire to the indicated terminal on the CPU board.  
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DKC 
Terminal 

DKC Wiring 
Reference 

Suggested Wire 
Color 

DK-38 
Terminal 

+12V Positive DC supply lead Red DC+ 

D0 Wiegand data zero Green D0 

D1 Wiegand data one White D1 

LED-G Green light Orange GRN 
LED-R Red light Brown RED 
LED-Y Yellow light Blue YEL 
BUZ Audible buzzer Yellow BUZ 

TAMP Tamper indicator Purple TAMP 

(-) Ground Black  GND 
 

Table 2: Wiring Terminal Connections 

 
Note that suggested wire color for ‘LED-Y’ terminal is BLUE and suggested wire color for ‘BUZ’ 
terminal is YELLOW. 
 
Power and Electric Lock Wiring  
When using transformers or power supplies with the DKC, select a transformer or power supply 
of the same voltage as the lock (12V or 24V).  
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DKC CPU Board Configuration 
 

 

AC Lock with AC Power 
When a fail secure lock operating on AC is used, power 
must be applied to release the lock. The two 
transformer secondary wires connect to the AC input 
terminals (there is no polarity with AC). Power from one 
terminal then goes to the common of the associated 
door relay. The NO contact of the relay will power the 
lock to release the door when a correct code is entered.  
Note that if the AC lock is fail safe (secure when 
powered) make the connection to the lock from the NC 
terminal. 

 

 

                                       DKC

COM
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Figure 2
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DC Lock with AC Power 
Most DC electric locks can be operated from an AC 
transformer when the DKC is used. The DKC converts 
the input AC to DC to operate the lock. The lock must 
accept full wave rectified DC power. This is true of most 
DC locks (including Securitron Magnalocks) but some 
specialty units require regulated DC power.  
 
The DC terminals furnish output power for the lock. DC 
locks must not draw more than 1 Amp. The positive DC 
terminal connects to the common of associated door 
relay and either the NO terminal (if the lock is fail 
secure) or the NC terminal (if the lock is fail safe) 
connects to the locks’ positive power input. Only 
connect one of these terminals. Consult lock 
instructions to determine if the lock is polarized and 
must connect lock power correctly to positive and 
negative.  
 
Note that many DC lock installations call for battery 
backup. To achieve this, employ a DC battery backup 
power supply.  
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DC Lock with DC Power 
The DKC does not require regulated power but certain 
specialized electric locks do. Please match the power 
supply to the requirements of the lock. DC locks come 
in fail secure (secure when not powered) and fail safe 
(secure when powered) versions. All magnetic locks are 
fail safe. The positive DC terminal connects to the 
common of associated door relay and either the NO 
terminal (if the lock is fail secure) or the NC terminal (if 
the lock is fail safe) connects to the locks positive 
power input. Only connect one of these two terminals. 
Consult lock instructions to determine if the lock is 
polarized and must connect lock power correctly to 
positive and negative.  
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Adding Other Lock Control Switches  
Sometimes other control switches are needed that are not appropriate for the REX input, as use 
of this input triggers the timed release capability of the DKC. A typical example would be a 
switch located centrally which would release the lock in response to an intercom call for 
example. If the lock is fail safe, the switch will need to break power to the lock and if it is fail 
secure, the switch will need to send power to the lock. Figure 5 shows how to add external 
contacts for non-timed remote release of the lock for both lock types. 

 

COM

ADDING EXTERNAL CONTACTS FOR FAIL SAFE AND FAIL SECURE LOCKS

Figure 5
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Connecting to ASSA ABLOY AperioTM Products  
AperioTM technology is a global wireless platform that reduces the cost and inconvenience of 
traditional access control – without the hassle of complex site surveys. It utilizes local wireless 
communication between the lock and a communications hub to connect to an online electronic 
access control system. This offers facilities an easy, affordable way to expand the reach of 
existing access control systems and secure additional openings. 
 
When using AperioTM products with the DKC, an AH20 AperioTM Wiegand Hub must be used. 
Please note that the green/red light logic must be set to ‘Reverse’. Additionally the ‘Aperio hub’ 
option button must be selected on the ‘Keypad/Aperio Hub’ option for the associated door. These 
options are selected in the Door Options tab in the DKC Programming Tool. Please note that 
Passage mode CANNOT be used with an AperioTM hub. AperioTM products conform to higher 
security requirements that do not allow passage mode to be used. 
 
Wiring the Aperio TM hub to the DKC is shown in Table 3 and Figure 6.  
 

DKC 
Terminal 

DKC Wiring Reference 
Suggested 
Wire Color 

Aperio Hub 
Terminal 

+12V Positive DC supply lead Red 8-24V DC 

D0 Wiegand data zero Green D0 

D1 Wiegand data one White D1 

LED-G Green LED Orange GREEN 
LED-R Red LED Brown RED 
(-) Ground Black  GND 

 
Table 3: Minimum Wiring Terminal Connections from DKC to Aperio hub 
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WIRING THE DKC TO THE APERIO HUB
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Figure 6

Suggested Wire Colors Shown

Red Wire

Black Wire

Orange Wire

Brown Wire

Green Wire

White Wire

Red Wire

Black Wire

Orange Wire

Brown Wire

Green Wire

White Wire

 
The Dip 1 switch called ‘A0’ on Aperio TM hub must be switched to ‘ON’ to connect with the DKC. 

DIP Switch Position  
The DKC controller is shipped from the factory with the DIP switches set with ‘Facility Only’ 
turned OFF and in 2-door operation mode. If the DKC is being used in a man trap application, 
DIP switch 1 labeled “Man Trap” must be switched to the ON position. If facility codes are being 
used, DIP switch 2 or 3 must be turned ON for the corresponding door and the facility code must 
be entered in the Door Options tab.  

Additional Hard Wired Options  
 
The Request to Exit Function (REX) 
Additional control devices such as an exit switch may be required if a solenoid operated lock or 
electromagnetic lock is used. Connection of exit switches is most easily accomplished by using 
the DKC's Request to Exit or REX input terminal.  
 
When a normally open switch activates the REX 
terminal, the DKC's control relay will open the lock for 
the amount of time programmed into the DKC's access 
relay timer. The result is the same as if the DKC was 
used from the outside of the door. The REX terminal is 
activated by being connected to the +12V (voltage 
source) terminal.  

+12V REX

THE REX FUNCTION

Figure 7

AN NO SWITCH 
CLOSING BETWEEN 
“+12V” AND “REX” 
CAUSES TIMED 
RELEASE OF THE 

DOOR

 

 

There are some special characteristics as to how the REX input works. It does not start the timer 
when the input is closed but rather when it reopens; therefore, the REX input can be used to 
release the door for an extended period of time. As long as terminals REX and +12V remain 
connected, the lock will be released. When they disconnect, the lock will remain released for the 
amount of time programmed. The REX input is also re-triggerable. This means that if the lock 
has been released and the REX input is triggered, the release time will be extended to the full 
value that has been programmed.   
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When using exit switches, the possibility must be considered that an electronic failure may occur 
to the DKC and a person will not be able to exit. If the DKC controls the only door exiting the 
area, additional steps should be taken to improve the reliability of exiting so as to avoid trapping 
someone. This can most easily be done by implementing a secondary means of releasing the 
lock not dependent on the DKC's REX input. Additional switch contacts should be used that 
directly control the electric lock. In the case of a fail safe lock, which should always be employed 
when there is only one exit path, this can be easily accomplished with "double break" wiring 
between the exit button, electric lock, and DKC. If the exit button has a set of normally open 
and normally closed contacts, it should then be wired according to Figure 8 or Figure 9 below. 
When the exit button is depressed, its normally closed contacts directly break power to the lock 
while its normally open contacts activate the DKC. If for any reason a failure occurs with the 
DKC, a person can still exit by holding the exit button down while pushing the door open. 
Always consult local building or fire department when securing doors that are part of 
an emergency exit path to ensure compliance with local codes. 
 

                                       DKC
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Figure 8
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Figure 9
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Man trap Function  
The DKC can be set up to operate two doors to work together as a man trap function. In order to 
use the man trap function, the DKC must be programmed with a user code on each door. The 
door position switches must be connected to each door as in Figure 10. The DIP switch 1 labeled 
“Man Trap” must be switched to the ON position. Always consult local building or fire 
department when securing doors that are part of an emergency exit path to ensure 
compliance with local codes. 
 
Anti-Tailgating  
Particularly when using the longer time ranges, the user 
may be concerned that after an authorized person has 
used the door, a second unauthorized person can also 
use it before the lock has reset. By the addition of a 
door switch which opens when the door opens, the DKC 
can be made to re-engage the lock as soon as the door 
has re-closed regardless of the status of the timer. This 
feature can be implemented either using the DKC 
Programming Tool or using a system keypad.  
 

ANTI‐TAILGATING

Figure 10
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Hard Wired Code Disabling  
Hard wired code disabling means making a switch 
connection to the CPU board which will cause valid 
codes to not be accepted. The DKC has two terminals 
marked “HCD” and “UCD” which will respectively disable 
the Hard code and all User codes. Simply connect the 
+12V terminal to either of these terminals via an 
external switch and the respective codes will not 
function while the switch is closed.  
 

C

SPDT SWITCH 
OR RELAY

+12V

Figure 11

WITH THE CONTACTS AS 
SHOWN, THE HARD CODE 
IS DISABLED.  WHEN THEY 
SWITCH ALL USER CODES 

WILL BE DISABLED.

HARDWIRED CODE DISABLING

UCD HCD

NO

NC

The purpose for hard wired code disable is to support day/night operations. For example, all 
User codes are active during the day but disabled at night by closing a switch between +12V and 
UCD. The Hard code would be the only method of entry at night, or, there could be no Hard code 
programmed so that there would be no entry at night. This could be done by SPDT switch or 
relay timer controlled contacts from a timer such as the Securitron DT-7.  

System Reset  
A system reset will clear the DKC of all programmed codes and reset the unit to factory settings. 
If a complete system reset is required: 

 Press and hold the push button switch on the DKC CPU board.  
 Turn DKC power on. Continue holding the push button switch for 10 seconds. 
 When ‘C’ is illuminated on the display, all codes and options have been erased and 

returned to factory settings.  

Battery Maintenance  
The battery on the DKC CPU board is used to maintain the correct time for the event log in the 
event of power failure. Remove battery tab prior to installing the DKC. The battery should be 
replaced every 5 years. When installing a new battery, verify the correct battery orientation by 
checking the CPU board for polarity (BAT+).   

The DKC Programming Tool  
The DKC Programming Tool runs on any of the following operating systems: Windows XP, 
Windows Vista, or Windows 7. Before beginning, ensure the computer meets the system 
requirements for the DKC Programming Tool and DKC controller. The DKC Programming Tool is 
supplied on a memory stick. Ensure the computer is equipped with a USB port. Connect the DKC 
controller to the computer loaded with the DKC Programming Tool using the supplied USB cable. 
Please visit Securitron.com for the latest update to the Programming Tool. 
 
If a “Common Language Runtime Error” is encountered during Programming Tool installation, it 
is easily resolved by visiting www.Microsoft.com and downloading “Microsoft .NET Framework 4 
(Web Installer)”. 

Connecting the DKC to the DKC Programming Tool  
Using the memory stick provided, install the DKC 
Programming Tool onto a PC or laptop computer. Once 
the application is opened, the DKC Status Form displays 
the status of the DKC controller. When the DKC 
controller is not connected to the computer with the 
DKC Programming Tool the following message will 
appear:  

Status: No DKC connected 

 
  

RED 
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When the red octagon appears on the form, the DKC Configuration form is accessible, but the 
following tabs will be grayed out and unusable: 

 Import/Export tab  
 Real Time Clock tab   
 Event Log tab 

 
To connect the Programming Tool to the DKC controller plug one end of the USB cable into the 
USB port on the computer. Plug the other end of the cable into the DKC controller. The 
connection is now complete. The DKC may be powered by connecting it to a Securitron power 
supply, a plug-in regulated power supply or an AC transformer.  
 
Once connected and powered the orange octagon will 
appear on the form, which means the USB port of the 
DKC must be unlocked either by using the user-defined 
USB Enable code or USB Enable card (if a Wiegand card 
reader or AperioTM hub is being used). 
 

  
Status: DKC found but unit is locked and 
sign-in has not been done 

 
If the DKC has no USB Enable code, one must be programmed to access the DKC Programming 
Tool. The USB Enable code allows the user to enable (unlock) the USB port of the DKC. This 
must be done before any data can be imported or exported between the DKC and the host 
computer. Ensure that the slide switch on the DKC CPU board is set to the correct door 
corresponding to the installed keypad or credential reader. On the DKC CPU board, press the 
push button switch SW2 until a ‘5’ is shown on the display. The yellow LED on the digital keypad 
will flash once per second (if connected to a DK-37 or DK-38). Within 30 seconds enter a 2 to 7 
digit code then press the * key. The red LED will flash twice signifying acceptance of the USB 
Enable code. The display on the CPU board will turn off. If the DKC is connected to a credential 
reader, present the USB Enable card instead of entering a 2 to 7 digit code that the keypad. 
Note that only one USB Enable code may exist per door in the code database.   
 
Once the code or card is entered, proceed with the steps shown in The Status Form section. 
When using a DK-37 or DK-38 keypad type in the code on the keypad, followed by the * 
(default) button. If the * has been programmed as the doorbell key, then use the # key instead. 
 
How to Sign In 
The yellow octagon appears if a username and password has already been programmed into the 
DKC. For information on how to program a username and password into the DKC, see the 
Custom Names and Security section of this document.  
 
Click on the picture of the yellow octagon for the sign-in 
box.   
 
If the username or password is forgotten, click the 
‘Forgot Your Username and/or Password’ link to display 
the Username Password and Recovery dialog box. 
  

Status: DKC found & unlocked but sign-
in has not been done 

 

YELLOW 

ORANGE 
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When the green octagon appears, the DKC 
Programming Tool is connected to the controller and 
ready to communicate with the DKC.  
 
Click on the picture of the green octagon to start the 
programming the DKC.  

  
Status: DKC ready for use 

DKC Programming Tool Overview 
The Securitron DKC Programming Tool allows easy programming from a computer using an 
easy-to-use graphical interface. An event log displays detailed information to help 
troubleshooting problems or errors. 
 
When connecting the DKC to a computer all information stored in the DKC must be IMPORTED 
into the Programming Tool. Once changes are made in the Programming Tool the information 
must be EXPORTED to the DKC for the changes to be in effect. 
 
About the Three Forms 
The DKC Programming Tool interface is comprised of three Forms: the Status Form; the 
Configuration Form; the Event Log Form.  

The Status Form 
The Status Form indicates the status of the DKC 
Programming Tool and consists of: 
 A visual status queue (a colored octagon)  
 A status bar (at the bottom of the form), indicating 

status of DKC Programming Tool  
 Two pull-down menus: the Program menu and the 

Help menu  
 
To open the Configuration Form and begin programming 
the DKC, click in the center of the green octagon. 

 
Status: DKC ready for use 

The Configuration Form 
The Configuration Form has six tabs: a database tab for each door, an option tab for each door, 
an option relays tab and a customization and security tab. The Configuration Form contains five 
menus, plus the online Help menu: Project, Edit, Import/Export, Real-Time Clock, and Event 
Log.  
 
Configuration Form Tabs 
 
The Database Tabs 
The Configuration Form contains two 
database tabs; one for each door. Up to 
250 codes can be recorded per database.  
 

 
 

 

GREEN 

GREEN 
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The Code Style Field  
Located in the lower left-hand corner of the Database tabs, the Code Style field contains a menu 
with two selections. Note that when the code style is changed, the on-screen database is erased. 
Character: to be used with the Securitron DK-37 and DK-38 keypads. 
Wiegand 2601: to be used with any Wiegand 2601-compatible device including the AperioTM 
AH20 hub. 
 
The Columns 
The Configuration Form contains either four or five columns depending upon the Code Style 
selected at the bottom left corner of the Configuration Form. When Character is selected four 
columns appear. When Wiegand 2601 is selected five columns appear: 
Record Number: Indicates the record number, and is un-editable. 
Code Type: This column has a pull-down menu to select a code type for each record. There are 
various codes that can be programmed into the DKC depending on the keypad/reader connected 
to it. Note that in the table below “code” refers to any code entered on a keypad or card 
presented to a Wiegand 2601 device. 
 

Code Name Definition 
Applicable 
Devices  

Master Allows the Master user to enter program mode with 
unrestricted access. There can only be one Master Code 
in the code database. Master code must be 5 to 7 digits 
in length.  

Used only with a 
DK-37 or DK-38  

Supervisor Allows the Supervisor user to enter program mode with 
limited access. Only user codes and one-time codes can 
be added and/or deleted. There can only be one 
Supervisor code in the code database. Supervisor code 
must be 5 to 7 digits in length. 

Used only with a 
DK-37 or DK-38  

Hard Allows simple single code “fixed” operation. It can also 
be used to trigger an option relay set for duress mode. 
There can only be one Hard code in the code database. 
Hard code must be 2 to 7 digits in length when using a 
DK-37 or DK-38. 

Can be used with 
any connected 
keypad or reader 

Master Add Allows the user to program a new user code. The code 
that is entered immediately after is learned as a new 
user code. There can only be one Master Add code in the 
code database.  

Used only with a 
Wiegand 2601 
device. 

Master 
Delete 

Allows the user to delete a user code. The code that is 
entered immediately after is deleted from the database. 
There can only be one Master Delete in the code 
database.  

Used only with a 
Wiegand 2601 
device. 

USB Enable Allows the user to enable (unlock) the USB port of the 
DKC. This must be done before any data can be 
transmitted or received between the DKC and the host 
computer. There can only be one USB Enable code in the 
code database. USB enable code must be 2 to 7 digits in 
length when using a DK-37 or DK-38. 

Can be used with 
any connected 
keypad or reader 
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Code Name Definition 
Applicable 
Devices  

Passage Allows the user indefinite uncontrolled passage through 
an opening. Entering the Passage code again returns 
operation to normal. Lockout and man trap modes take 
precedent over passage mode. Any attempt to put the 
DKC in passage mode while either lockout or man trap 
modes are active will result in an error. There can only 
be one Passage code in the code database for the DK-37 
and DK-38 but multiples can be used on Wiegand 2601 
devices. Passage code must be 2 to 7 digits in length 
when using a DK-37 or DK-38. 

Can be used with 
any connected 
keypad or reader; 
EXCEPT an AperioTM 
hub.  
Aperio products 
conform to high 
security 
requirements that 
do not allow 
passage mode to 
be used. 

Lockout Allows the user to lock the keypad or reader indefinitely. 
Entering the Lockout code again returns operation to 
normal. The REX can still be used while lockout mode is 
enabled to allow exiting. There can only be one Lockout 
code in the code database for the DK-37 or DK-38 but 
multiples can be used on Wiegand 2601 devices. Lockout 
code must be 2 to 7 digits on a DK-37 or DK-38.  

Can be used with 
any connected 
keypad or reader 

One-Time Allows access but is automatically erased when it is 
used. There can only be one One-Time code in the code 
database. One-time code must be 2 to 7 digits on a DK-
37 or DK-38. 

Can be used with 
any connected 
keypad or reader 

 
Facility Code: Use this column when the code style (selected in the lower left-hand corner of 
the Configuration Form database tab) is set for Wiegand 2601. This column can contain numbers 
from 0 to 255. 
User ID: The user ID is the unique number by which a user is recognized. This column can 
contain numbers from 0 to 65535 
User Name: The use of this column is optional. It is used to associate a name to a user code. 
 
The Door Options Tab 
There are two Door Options tabs—one for 
Door 1 and one for Door 2, each with a total 
of ten options per door.  
 
AperioTM Products  
Please note that the green/red light logic 
must be set to ‘Reverse’ when an AperioTM 
AH20 Wiegand hub is being used. 
Additionally ‘Aperio hub’ option button must 
be selected on the ‘Keypad/Aperio Hub’ 
option for the associated door.  
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The Options Relay Tab 
There are three programmable 5 Amp 
option relays for each door that are marked 
on the CPU board as NC, COM, and NO. 
Each relay can perform one of the functions 
listed below and can be assigned to one 
door. These functions are chosen using this 
tab to select the relay and options for each 
door. The option relays can also be 
programmed directly on the DKC CPU board 
while the unit is in Programming Mode.  
 

 

Note that a door position switch (DPS) is used to monitor the status of a door. A DPS is required 
for alarm shunt, door prop and forced entry option relays. A DPS is also required for each door 
operating in a man trap.  
 
Alarm Shunt  
If a door opens without the DKC being
activated, an alarm signal should result.
When the DKC is employed to open the
door, the alarm should be shunted. The
relay energizes when the access relay
energizes and will remain energized while
the access relay is energized. When the
access relay de-energizes, the alarm shunt
relay will remain energized for an additional
amount of time dictated by the door prop
time. Note that a door position switch (DPS)
is required for alarm shunt function.    
 

Figure 12

ALARM SIGNAL WHICH IS 
OPEN WHEN DOOR IS 
CLOSED; CLOSES TO 

ALARM

WIRING TO SHUNT ALARM SYSTEM ON DOOR

ALARM SIGNAL WICH IS 
CLOSED WHEN DOOR IS 
CLOSED; OPENS TO 

ALARM

DOOR 
SWITCH

NC COM NO

TO ALARM PANEL

DOOR 
SWITCH

NC COM NO

TO ALARM PANEL

 
Camera Call-Up 
When a valid code is entered the camera call-up is initiated to record activity during door 
opening. The relay energizes for a half second after a valid access code is entered. 

 

Door Prop Alarm Function  
This function provides enhanced security 
at the door by creating an alarm signal 
any time the door is left open too long 
while being used for entry or exit. A 
relatively long door open time must be 
selected when this function is enabled. A 
door position switch (DPS) is required for 
this application whose contacts open when 
the door opens. 
 

DOOR SWITCH

+12V
DOOR 
POS

Figure 13

CONNECT A DOOR 
SWITCH WHICH 

OPENS WHEN THE 
DOOR OPENS FROM 
+12V TO DOOR POS

DOOR PROP ALARM

 

If the door remains open for a longer period of time than is set on the timer, the programmable 
relay will switch and will remain energized until the door closes or the keypad is used again. 
Connection from the programmable relay is generally not made to an alarm system, because if 
an alarm system is active on the door the same “door open too long” signal can be 
communicated simply by using the second pole of the lock NC NO control relay to shunt the door 
switch. Generally, a Sonalert will be mounted on the CPU board enclosure. It will sound if the 
door is left open too long and will act as a prompt for someone near the door to close it.  
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Figure 14
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Tamper  
If a total of 16 wrong digits are entered, a continuous audible alarm sound is made and the 
keypad will lock itself out for 30 seconds while the green light remains on constantly. After the 
30 second lockout the audible alarm will silence, the green light will turn off, and the keypad will 
become active. This feature discourages attempts to guess the code. The relay remains 
energized as long as a tamper signal (ground/common) is present at the tamper input. 
 
Duress  
The duress function is used for high security applications. It allows a person being threatened to 
release the door but simultaneously trigger a silent alarm, which would be employed to summon 
assistance. The DKC establishes the Hard code as the duress code. The relay energizes when the 
Hard code is entered and will remain energized until the Hard code is re-entered to reset it. 
Duress function must be selected in two places in the DKC Programming Tool: the duress option 
must be selected on the Door Options tab and one of the three option relays must be selected 
for the duress function.  
 
Door Bell 
The purpose of the door bell function is to 
allow unauthorized persons outside the 
controlled door to request entry. The relay 
energizes for one second after the door bell 
button is pressed. 

COM NO

Figure 15
DOORBELL FUNCTION

DOORBELL 
POWER SUPPLY

 

Forced Entry  
If a door opens without the DKC being activated, an alarm signal should result until a valid code 
is entered and the door is closed. The relay energizes if the door opens without a valid access 
code being entered. The relay remains energized until the door is closed. Note that a door 
position switch (DPS) is required for forced entry function as in Figure 13.    
 
The Custom Names and Security Tab 
Completing the information in the Security tab is optional. It contains two sections: 
Custom Names: In this section, a name is assigned to the unit itself, as well as a name to each 
of the doors. The names are a maximum of 16 characters each. Everywhere ‘Door 1’ and ‘Door 
2’ appear in the Programming Tool will now be replaced with the customized names assigned to 
the doors.  
Security: Add a second layer of protection 
to the DKC port in this section. A username 
and a password can be added as well as a 
recovery security question and answer, in 
case the username and/or password is 
forgotten. The username, the password, 
and the answer to the security question are 
all 16 characters maximum. 
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Configuration Form Menus 
The Configuration Form contains five menus, plus the online Help menu: 
1. Project 
2. Edit 
3. Import/Export  
4. Real-Time Clock 
5. Event Log 
6. Help 
 
The Project Menu 
The Project menu allows access to door programming project with three selections: 
Open Configuration File: The Configuration file contains all information for the tabs except the 
Event Log tab, which has its own file. 
Save Configuration File: This selection saves all information entered in the Configuration file. 
Exit: This selection closes the Project menu. 
 
The Edit Menu 
The Edit pull-down menu contains two selections:  
Copy: Copy the information from a database tab or copy one door options tab to another door 
options tab. 
Paste: Paste the information from one database tab into another database tab. 
 
The Import/Export Menu 
When connecting the DKC to a computer all information stored in the DKC must be IMPORTED 
into the Programming Tool. Once changes are made in the Programming Tool the information 
must be EXPORTED to the DKC for the changes to be in effect. The Import/Export pull-down 
menu contains two selections: 
Import Configuration: Uploads all configuration information from the DKC into the computer.  
Export Configuration: Downloads all configuration information from the computer into the 
DKC. 
Note that when importing Configuration data, it will erase and replace ALL configuration 
information currently in all the tabs. 
 
The Real-Time Clock Menu 
The Real Time Clock pull-down menu contains three selections:  
Show Current Date/Time: Click this selection and the current date and time stored in the DKC 
is displayed. 
Set Date/Time from System: Click this selection and the current date and time stored in the 
computer is sent to the clock inside the DKC  
Set Date/Time Manually: This selection allows the date & time of the DKC to be entered 
manually in either a US (m/d/yr) or international (d/m/yr) format. 
Note that the only time the date format is seen is when the event log is displayed or when the 
user requests the date and time of the DKC 
 
The Event Log Menu 
The Event Log Menu selection displays three pull-down items: File, Event Log, Help 
 
File 
This selection has six options: 
Open Event Log: Open an Event Log from the computer. The system will ask which event log to 
open. Select the name of the log to open – the system will prompt for user name and password.  
Save Event Log: Save all the events listed in the current log being displayed, to the computer – 
the system will prompt for a user name, password and a security question (depending upon user 
configuration).  
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Page Setup: Select the paper size, source, orientation (portrait or landscape) and margins, and 
printer.  
Print Preview: Preview what the Event Log will look like prior to printing it.  
Print: Print the active document. 
Exit: Close the Event Log screen. Note that selecting Exit will delete all Event Log information 
currently displayed. 
 
The Event Log 
The Event Log selection has four options: 
Read All Events: Uploads all events from the DKC (the entire event log) from the DKC to the 
computer.  
Number of Events Displayed: Provides a count of how many events are currently displayed. 
Read Only New Events: Only reads in events that are new since the Event Log was last read. 
Clear Displayed Events: Clears all events from the log. 

DKC Programming Using the DK-37 or DK-38 Digital Keypads  
Advanced programming features can be accessed through a connected DK-37 or DK-38. These 
features allow a user to customize the operation of the DKC to fit the specific needs of their 
installation. Please note that the keypad is shipped in ‘Wiegand mode’ from the factory. When 
interfacing with the DKC, please change the keypad to ‘Character mode’ and ensure that 
‘Character’ is selected in the DKC Programming Tool.  
 
There are two programming levels available to the user. In master program mode all 
programming can be done without restriction. In supervisor program mode only commands 
related to user or one-time codes can be accessed. 
 
Enter Programming Mode  
Enter master or supervisor code on the keypad, then press the * key. Yellow light will flash 
indicating the digital keypad is now in programming mode. Note that once in programming 
mode, the yellow light will continue to flash until program mode is exited by pressing the * key 
or after a 30 second timeout period. 
 
Setting a Code  
Once in programming mode, enter a single digit prefix to indicate the type of code being 
entered: 

1 = Master Code 5 = USB Enable Code 
2 = Supervisor Code 6 = Passage Code 
3 = User Code 7 = Lockout Code 
4 = Hard Code 8 = One-Time Use Code 

 
Then enter the desired code and press the * key.  
The red light will flash twice to confirm a valid entry has been entered. Note that the code length 
for master and supervisor codes must be 5 to 7 digits long. Code length for all other codes must 
be 2 to 7 digits long. 
 
Deleting a Non-User Code  
Once in programming mode, enter the single digit prefix to indicate the type of code being 
deleted (same codes as above for setting a code), then press the # key twice to complete the 
deletion. The red light will flash twice to confirm deletion.  
 
Programming Special Functions  
Once in programming mode, enter the two or single digit command followed by the * key; see 
table below for the commands. The red light will flash twice to confirm when the command is 
completed.  
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Command Function 

70* 
Turns on the double beeper chirp that sounds when the relay is 
energized by a valid code or REX (not used in toggle or passage 
modes) 

71* Turns off the double beeper chirp (default) 
72* Turns on the key press single beeper chirp (default) 
73* Turns off the key press single beeper chirp 

74* 
Reverses light logic (red to echo key presses and green to show relay 
is energized) 

75* 
Returns light logic to factory setting (green to echo key presses and 
red to show relay is energized) 

76* 
Duress option turned on. Use of hard code releases door and trips one 
of the three option relays. Note that one of the three option relays 
must be setup for this function; see code 78* 

77* Duress option turned off (default) 

78* 

Program option relay. By default there are no functions assigned to 
any of the three relays. Follow the command by the relay number (1, 
2, or 3) followed by one of the function numbers listed below: 
1 = Alarm Shunt 
2 = Camera Call-Up 
3 = Door Prop 
4 = Keypad Tamper 
5 = Duress 
6 = Door Bell 
7 = Forced Entry 

79* 
Delete a User code. Any valid user code entered will be deleted. Press 
the # key twice to complete the deletion. 

80* 
Anti-tailgating option turned on. When the door position switch closes 
the lock re-secures regardless of the status of the relay timer. 

81* Anti-tailgating option turned off (default) 

82* 
Door bell button assigned to the # key (default). Note that one of the 
three option relays must be setup for this function; see code 78* 

83* 
Door bell button assigned to the * key. Note that one of the three 
option relays must be setup for this function; see code 78* 

84* 
Set real time clock in “US” mode. Follow the command by mm dd yy 
hh mm (month, day, year, hour, minute).  Enter hours in 24-hour 
time format (i.e. 12am = 00, 9am = 09, 12pm = 12, and 9pm = 21). 

85* 

Set real time clock in “International” mode. Follow the command by 
dd mm yy hh mm (day, month, year, hour, minute). Enter hours in 
24-hour time format (i.e. 12am = 00, 9am = 09, 12pm = 12, and 
9pm = 21). 

86* 
Erase all User codes in the database. Press the # key twice to 
complete the erasure. The yellow LED on continuously indicates that 
there are no codes in the database. 

87* 
Followed by ‘00’ through ‘99’ sets the door prop timeout in seconds 
(defaults to 5 seconds). 

88* 
Erase all codes except master, supervisor, and hard codes. Press the 
# key twice to complete the erasure. 

89* 
Returns all functions (including timers) to factory default settings; all 
codes are unchanged. Press the # key twice to complete factory reset. 

9* Followed by ‘00*’ puts the relay in toggle mode 

9* 
Followed by ‘01’ through ‘99’ sets relay timeout in seconds (defaults to 
5 seconds). 



 
 

 PN# 500-33510 
 Page 19 Rev. A, 06/13 

Deleting all codes except Master, Supervisor, and Hard codes:  
 Enter the master program code followed by the * key and the yellow LED will flash once per 

second 
 Enter 88* followed by # twice 
 After less than 2 seconds the red LED will flash twice 
 Exit programming mode by pressing either the * or # key and the yellow LED will stop 

flashing 

DKC Programming Options on the DKC CPU Board 
1. Slide switch to select door to be programmed  
2. Press push button switch SW2 until the desired code option is reached  

0 for Master code (DK-37 DK-38) 
1 for Supervisor code (DK-37 DK-38) 
2 for Hard code  
3 for Master Add Card (Wiegand only) – AKA: User Code Add 
4 for Master Delete Card (Wiegand only) – AKA: User Code Delete  
5 USB enable code 
6 for Passage code 
7 for Lockout code 
8 for One-Time Use code 
9 Learn Facility code (Wiegand only) 

3. Yellow light on keypad will flash indicating DKC is in Programming Mode. Yellow light will 
continue to flash until Programming Mode is exited or after a 30 second timeout period. 

4. Enter the code at the keypad followed by * key. Red light flashes twice for a valid code entry. 
 
Note: Master and Supervisor codes must be 5 to 7 digits, user codes must be 2 to 7 digits long 
for DK-37 and DK-38  
 
Technical Support 
For general questions concerning this or other Securitron products please visit the Securitron 
website www.Securitron.com or contact Securitron Technical Support at (800) 624-5625 
or email TechSupport@ASSAABLOYEMS.com  
 
 
MagnaCare Lifetime Replacement Warranty  
For MagnaCare Lifetime Replacement Warranty information please visit: 
www.securitron.com/en/site/securitron/About/MagnaCare-Warranty/ 
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